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Introduction

Introduction
Welcome to TheBrain 12! Just when you thought your Brain couldn’t get better,
TheBrain 12 makes connecting information virtually effortless. With seamless
discovery of related content, automatic display of backlinks, and a redesigned
Content Area, your ideas and knowledge will come to life like never before.
TheBrain 12 new features include:
Sleek New Redesign of the Content Area
Viewing Related Thoughts in the Content Area
Faster Ways to Create Thoughts and Links
Viewing Attachments in Slideshow Mode
Dragging and Dropping Images, Links, and Text within Notes
Merging Thoughts
Encrypting Individual Attachments
And many other enhancements …
A video overview of these features is available at
https://www.thebrain.com/TheBrain12

About this Guide
This guide covers the new features and changes in TheBrain 12 that have been
made since version 11. It is intended for people who are already familiar with
version 11.
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Redesigned Content Area

Redesigned Content Area
You’ll find that the Content Area is now simpler, with a more space-efficient
design.

Figure 1. The Content Area

Specific enhancements include:
•

Increased speed—all types of attachments are added more quickly.

•

Improved drag and drop for attachments—the Thought name is
highlighted as you drag and drop, and once dropped, the attachment
shows below the Thought name, instead of on a separate tab.
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Redesigned Content Area

Figure 2. Dragging and Dropping an Attachment

•

You can insert images and URLs directly into Notes—just drag and
drop the item within the body of the text area.

Figure 3. Dragging and Dropping an Attachment

•

Events are shown directly in the Content Area—previously, they were
listed on a separate Events tab within the Content Area.

Figure 4. Events Appear at the Top of the Note
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Redesigned Content Area

•

The Thought name appears as a title at the top of the Content Area—
and, of course, if you edit the title here, the Thought is renamed globally,
and vice versa. You can hide the title using the Include title option on the
Notes Editor tab in Preferences.

Figure 11. Show or Hide the Thought Title in the Content Area
•

Enhanced web content display—web pages from URLs in Notes are
displayed in TheBrain’s embedded browser.

The BrainBox also utilizes this redesigned Content Area. You can also give
the BrainBox its own tab by clicking its icon, then selecting Open in New Tab
in the context menu.

Collapsing and Expanding Notes Sections
Now you can collapse sections of your Notes based on headings, tables, and list
items. This helps you navigate through large documents more easily. Collapsing
lets you focus on a particular area while writing or reviewing content. When
you’re ready, you can expand any or all sections.
Two ways to expand or collapse Notes sections:
•

Hover over the area to the left of the Notes, then click the down-arrow to the
left of the section to collapse the entire list. This symbol will become a rightarrow which you can click to expand the section.

Or
•

Right-click in the Notes area, then click an option of your choice. Optionally,
before you right-click, click in a specific section if you want to collapse or
expand just that section.

Choices on the context menu include: Collapse All Except Here, Expand All,
Collapse All, Expand Here, and Collapse Here.
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View Related Thoughts in the Content Area

Figure 5. Options for Expanding or Collapsing Note Sections

View Related Thoughts in the Content Area
Have you ever wondered whether content in one Thought’s Note is referencing
another Thought in the same Brain or even if the Thought you are on is being
referenced in another Note—but you figured it might be too complicated to go
searching? You’ll love these new features. In TheBrain 12, without doing a thing,
you’ll instantly be presented with all related Thoughts in the Content Area.
Related Thoughts do not have to be visible in the Plex in order to display in
the Content Area.

Thought Mentions
When a Thought name appears within Notes, your Brain recognizes it
automatically as a “mention.” Both plural and singular forms of the text are
recognized, so exact matches are not required.
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View Related Thoughts in the Content Area

Figure 6. A Thought Mention Underlined in a Note
Right-click on a Mention in a Note to either link to or activate this Thought.

Figure 7. Context Menu When Right-Clicking on a Mention
Below the Note, users have the option of displaying more related content within
the same Brain by opening Mapped Links, Backlinks, or Unlinked Mentions in a
footer that can appear below the Note:
Mapped Links:

Thoughts that are connected in the Plex as parents,
children, jumps, or siblings (but do not necessarily
have text in common)

Backlinks:

Thoughts whose Notes link to the active Thought

Unlinked Mentions: Thoughts whose Notes contain the name of the
active Thought⎯even if not explicitly linked
While mapped links refer to Thought names, backlinks and mentions display both
the names of the related Thoughts and the context of the Notes in which they
appear.
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View Related Thoughts in the Content Area

Figure 8. Content Area with Related Thoughts in the Footer

Using Related Thought Links
You can open any related Thought by clicking its link in the Content Area footer.
This enables you to add content to one Note from another via links or mentions.

Figure 9. Two Kinds of Links for Related Thoughts

•

Click a solid blue link to activate that Thought.

•

In the footer, click a dashed underline link to display the Link this Mention
command. Once it’s linked to the existing mentioned Thought, it will move
from the Unlinked Mention section to the Backlinks section in the
Content Area.
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View Related Thoughts in the Content Area

Figure 10. After an Unlinked Mention is Linked

Note that while links appear in blue by default, you can easily change their
color. To do so, select Brain Theme in the Options menu, then click the color
of your choice on the Colors tab for the Links entry. Click Save Theme to
save your change.

Figure 11. Changing Link Color for the Current Theme
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View Related Thoughts in the Content Area

Hiding or Showing Related Thoughts
To hide mapped links, backlinks, or unlinked mentions in the Content Area:
•

Right-click below the Notes, then click Show Mapped Links, Show
Backlinks, and/or Show Unlinked Mentions in the context menu.

To restore the Thought names and/or links and mentions:
•

Right-click within the Notes area and click Show Mapped Links, Show
Backlinks, and/or Show Unlinked Mentions in the context menu.

Note that hiding or showing related Thoughts is global and applies to your entire
Brain.

Figure 12. Context Menu Below Notes

You can also use the Notes Editor tab in Preferences to hide or display links
and mentions in the Content Area.

Figure 13. Links and Mentions Section in Notes Editor Preferences
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View Related Thoughts in the Content Area

Collapsing and Expanding Related Thoughts Sections
When you hover over the area to the left of the related Thoughts, you’ll see
down- and right-arrows.
•

Click the down-arrow to the left of the current Thought name to collapse the
entire list. This symbol will become a right-arrow which you can click to
expand the entire list.

•

Click any other down- or right-arrow to expand or collapse that section or item.

Figure 14. Collapsing or Expanding Sections

You can also collapse and expand sections within Note text in a similar way
when Heading styles are used (see Collapsing and Expanding Notes Sections on
page 4).

Aggregating Content
The data in your Brain can be aggregated automatically with just a few simple
mechanics. When data is aggregated you can see content from Notes about the
same subject throughout the Thoughts in your Brain all at the same time. This
ability is powerful and magical!
In the example below, the four backlinks comprise every Note that begins with a
“George” heading throughout the Brain, organized by the name of the Thought
that contains one or more “George” headings.

Transitioning to TheBrain 12

10

View Related Thoughts in the Content Area

Figure 15. Aggregated Data for “George”

To prepare data to be aggregated:
1. Create a Thought whose name represents the information you want to see
aggregated. In the Figure 15 example, that Thought name is “George.”
2. In any Thought that has information about “George” (following this
example), precede the information with a standalone paragraph. This
paragraph should simply have the text that matches the name of the
Thought for which you want aggregated data—“George” in our example.
The text should be attached to a Heading stye.

Figure 16. “George” is Formatted as a Heading 3

3. Link the Heading by right-clicking it, then selecting Link (Thought name).
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View Attachments as a Slideshow

Figure 17. Linking the Heading to the Thought of the Same Name

4. In this scenario, the backlink content on the George Thought will display all
text until it comes to the next #3 (Heading) formatted text.
Any time you activate the “George” Thought, you’ll see the information
aggregated, as in Figure 15.

View Attachments as a Slideshow
The new Next and Previous navigational arrows in the top-right corner of the
Content Area toolbar make it easy to browse through attachments or pictures
within your Notes.
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View Attachments as a Slideshow

Figure 18. Next and Previous Arrows

To view attachments as a slide show:
•

Click the first attachment, then click the Next button to display the next
attachment.

•

For multi-page attachments, click a thumbnail to jump to a specific page.

•

To return to the Notes, just click the Close button (X) at the start of the
Notes toolbar (or keep clicking the Previous button until the Notes appear).

To view pictures in Notes as a slide show:
•

Double-click the image you want to see first to maximize it, then click the
Next button to display the next picture.
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Quick Thought Creation

Figure 19. A Picture from Notes in Slideshow mode

Quick Thought Creation
Now you can create a new Thought instantly from the Search box or within Notes
or Events.
Say you’d like a “Monthly Meetings” Thought to be a child of “My Work,” but
you’re not sure whether you already have a Thought with that name. You can
begin by searching, and if it doesn’t already exist, no need to retype the name.
To create a new Thought using search:
1. Activate the Thought that should be the parent, child, or jump Thought of
the new Thought.
2. Click in the Search box at the top-right corner of the window, then type the
name of the Thought you’re looking for, or want to create if it’s not found.
3. If the Thought doesn’t already exist and you want to create it:
•

Press the Enter key to create it as a child of the active Thought, or

•

Hold down the Shift key as you press the Enter key to create it as a
parent of the active Thought, or

•

Hold down the Ctrl key as you press the Enter key to create it as a jump
Thought of the active Thought, or
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Quick Thought Creation

•

Hold down the Ctrl key as you press the Shift key, then click on Create
Orphan to create it as an orphan Thought

Your new Thought will be the active Thought.

Figure 20. Creating a Thought from the Search Box

To create a new Thought when searching finds an existing Thought:
1. Press the up-arrow key. This highlights the default option—Create Child.
Note that pressing the Enter key before pressing the up-arrow key
activates the existing Thought.

Figure 21. Creating a Thought from the Search Box when the Thought is Found

2. Use any of the same key combinations for creating a new Thought from the
Search box when a Thought isn’t found.
To create a new Thought from within a Note:
1. Select the text within the Note for which you want to create a child, parent,
or jump Thought.
2. Right-click the selected text, then click the Insert Thought or Web Link
command. Optionally, you can revise the text in the new box that appears,
if you want a different name for the new Thought.
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Quick Thought Creation

3. Select a relationship for the new Thought:
•

Press the Enter key to create it as a child of the active Thought, or

•

Hold down the Shift key as you press the Enter key to create it as a
parent of the active Thought, or

•

Hold down the Ctrl key as you press the Enter key to create it as a jump
Thought of the active Thought

Figure 22. Creating a Thought from a Note

To create a new Thought from within an Event:
1. Open an existing Event or click and drag from the start to finish times in the
timeline to create a new Event.
2. Type a name for the new Thought where you see “No thought or link” at the
top of the Event box. A new orphan Thought will be created with that name.

Figure 23. Creating a Thought from an Event
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Fast Linking and Creating from Notes

Fast Linking and Creating from Notes
Pressing Ctrl/Cmd+K is a shortcut to:
•

Insert a link to an existing Thought

•

Create a new Thought

•

Link to a URL

•

Edit or remove a link

After you press Ctrl/Cmd+K:
1. An edit box opens so you can begin typing a URL or the name of the
Thought you want to perform any of these activities on. Or, if you select text
or a URL first, that text will appear in the edit box.
2. Double-click the entry that appears to insert a link to that item in the Note.
For example, double-clicking “Volunteer Opportunities” in the example
below creates a link to that Thought in the Notes for Goals.

Figure 24. The Ctrl/Cmd+K Shortcut

2. If an existing link is selected, you’re ready to begin editing it. To remove the
link, just delete its name in the edit box.
3. If you type a URL, it will be inserted.
The link command includes all the features of Quick Thought Creation so you
can insert all types of relationships easily.
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Using Drag and Drop within Notes

Alternatively, you can type [[ to link or create thoughts.

Using Drag and Drop within Notes
Now you can move images, links, and text in a Note via drag and drop. You can
also drag Note content to external applications.
To move text:
•

First select the text, then drag the selection

To move an image or link
•

Start dragging it, then drop it when the cursor is where you want the image
or link to be

Want to stop dragging? Just press the Escape key.

Other New Notes Features
You’ll find the following when you begin using Notes in TheBrain 12:
•

Thought and URL links have a cleaner look—the trailing icon is gone.

•

When Note text is selected and you paste in a URL, the selected text is
automatically linked to the URL.

•

By default, “smart quotes” (differentiated quotation marks) are inserted
automatically. This means that the opening quotation mark looks different
from the closing quotation mark you insert before and after words or
phrases.

•

When you rename a Thought, any references to it from other Notes are
automatically updated with the new name.

•

You can create your own keyboard shortcuts to switch text justification in
Notes between left, center, and right. Go to the Keyboard tab in
Preferences and expand the Notes section.
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Other New Notes Features

Figure 25. Creating Keyboard Shortcuts for Text Alignment in Notes

•

You can toggle to a "compact" Notes toolbar from the toolbar itself.

Figure 26. Expanding the Compact Toolbar from the Toolbar More Command
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Other New Notes Features

•

Under Windows you’ll notice improved scrolling when you’re using the
mouse wheel or touchpad.

Additional Notes enhancements are described in the sections below.

Content Only Mode
You can access most features and functionality right from within the Content
Area. This means that the Plex can be hidden while you concentrate on writing
and other tasks that are easier in a larger work space.

Previewing Notes in the Plex
With the optional Show notes indicators preference enabled in the Plex, small
icons appear on Thoughts containing Notes. Now, you can hover over these
icons to get an instant view of the corresponding Note.

Figure 27. “Show notes indicators” is Enabled

Content previews also appear, by default, based on Search box results. This
setting is on the Behaviors tab in Preferences.

Figure 28. “Show content previews when searching” is Enabled
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Other New Notes Features

Figure 29. Content is Shown on Hover Over Notes Icon

More Stylish Notes Styles
Your headings can be more expressive—you have access to ALL CAPS,
variable letter spacing , and alternative colors. You also have more control
over sizing.
•

New commands to copy, paste, import, and export styles make it easier to
create new styles.

•

A variety of new built-in styles are also included. Prebuilt styles are
grouped into Light, Dark, and Fun sections.
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Other New Notes Features

Figure 30. TheBrain 12 Edit Notes Style Window

To modify styles:
1. Click the More button, then click the Notes Style command (or if the Notes
toolbar is expanded, just click the Notes Style icon).

Figure 31. Opening the Edit Notes Style Window

2. Right-click within the sample text of the item you want to change, for
example, “Heading Example Text.”
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Other New Notes Features

Figure 32. Choice for Formatting Styles

3. Click the Apply button or press the Enter key to save your change and
close the window. Your change will be made in all Notes that have those
headings.

Figure 33. Before and After Changing the Heading Style to “All Caps”

Keyboard Shortcut for Links, Attachments, and Check
Boxes in Notes
When your fingers are already on the keyboard, there’s a new keyboard shortcut
in town that can save you a mouse click: Ctrl/Cmd+L
1. Make sure the text cursor is already blinking someplace within the Note,
then use the standard navigating keys to move the insertion point to any of
these items:
•

An item in a check box list

•

A link
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Other New Notes Features

•

An attachment

2. Press Ctrl/Cmd+L to toggle a check box on or off, follow a link, or open an
attachment.

Figure 34. Pressing Ctrl/Cmd+L Will Open the Link

Tab Key Functionality in the Notes Editor
When you’re typing in the Notes editor, the Tab key performs different functions
based on:
▪

Where the cursor is

▪

Whether text is selected
As in most text processing software, holding the Shift key while pressing the
Tab key reverses the direction of the action. For example, wherever pressing
Tab shifts text to the right, pressing Shift+Tab shifts text to the left.

If no text is selected and the cursor is within or at the start of a paragraph:
▪

The first line of the paragraph (whether it is one line or many) is indented
approximately five spaces each time the Tab key is pressed.

When the cursor is in a list item (bullets/check boxes/numbered lines):
▪

The entire list entry is indented approximately five spaces each time the Tab
key is pressed.

When the cursor is in a title, subtitle, heading, or subheading:
▪

The level of the heading is decreased each time the Tab key is pressed. The
heading level is increased each time Shift+Tab is pressed. For example, to
change a Heading 4 to a Heading 3, you would click in the text and press
Shift+Tab. (Heading 3 is a “higher level” than Heading 4.)
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New Dynamic To-Do Lists

When the cursor is in a table:
▪

Pressing the Tab key moves the cursor to the next cell.
Tab characters can’t be inserted into the middle of a line of text. If you want to
align text into columns, it’s most efficient to format using a table.

New Dynamic To-Do Lists
Now your to-do lists can practically complete themselves! Just as in previous
versions of TheBrain, you can create to-do lists within Notes by attaching text to
the Checkbox List style.

Figure 35. A Check List in a Note

As before, when you complete an item, you can click the check box and it’s
virtually checked off your list.

Figure 36. A Completed To-Do Item

Now you can see ALL of your to-do items in one place. To do so:
▪

Click the Right Panel button in the upper-right area next to the Search box or
click the To Do List command on the View menu.
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Merging Thoughts

Figure 37. Two Ways to Open the To Do List for All Thoughts

The To Do List panel is displayed:

Figure 38. Two Ways to Open the To Do List for All Thoughts

When you click a check box in one location, such as the To Do List panel, it is
automatically checked off in the other location (the Thought) and vice versa.

Merging Thoughts
Now you can automatically merge multiple Thoughts that refer to the same thing.
You can combine the links, attachments, and Notes so that the resulting Thought
has all of the information from those multiple Thoughts.
To merge Thoughts:
1. Ctrl+click on two or more Thoughts that you want to merge into a single
Thought. The Thought names will automatically appear in the selection box.
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Merging Thoughts

2. Right-click in the selection box, then click Merge (n) Thoughts.

Figure 39. Merging Three Selected Thoughts into One

When you activate the new Thought, you’ll see all content that was in each of the
standalone Thoughts. The name of the new Thought becomes a combination of
the formerly separate Thoughts, in alphabetical order.

Figure 40. Original Content Area of Three Thoughts Before Merging
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Encrypting Individual File Attachments

Figure 41. After Merging

Encrypting Individual File Attachments
Now you can encrypt Individual file attachments within your Brain using the
Encrypt command on an attachment’s context menu.
AES 256 bit encryption ensures that without the password, it is impossible to
recover the file contents from the encrypted file—even with administrator access
to the machine where the file is stored on a local computer or remote cloud
server.
Encrypted files cannot be searched and can only be decrypted via Windows and
macOS versions of TheBrain. These files are completely inaccessible even to
your hosting provider whether that be a private TeamBrain Enterprise Server or
TheBrain Technologies Cloud Server.
To encrypt a file:
1. Right-click the attachment, then click Encrypt in the context menu.
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Encrypting Individual File Attachments

Figure 42. After Clicking on the Attachment’s Context Menu

2. Type in the prompt you want the user to see when they attempt to open the
file, type a password, click the check box confirming that the file cannot be
opened if the password is lost, then click the Encrypt button.

Figure 43. Example Encryption Details

3. Whenever someone attempts to open the file, they’ll see the prompt you
entered. They will have to enter the correct password, then click the
Decrypt button. After that the file can be opened by clicking on it.
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More Improvements Throughout

Figure 44. Decrypting and Opening the File

More Improvements Throughout
You’ll find many other enhancements throughout TheBrain 12. Here are some of
the highlights:
•

You can find and execute commands from the Search box. To begin, type
a forward slash (/) in the Search box. An alphabetical list will appear. The
list will be fine-tuned to match what you type.

Figure 45. Executing a Command from the Search Box

•

The Wander algorithm has been improved so that you’ll be less likely to
revisit the same thoughts.

•

The initial startup time has been improved along with other performance
optimizations.

•

There’s better rendering of forgotten Thoughts in the Plex.

•

Event colors now inherit from associated Thoughts.

Transitioning to TheBrain 12

30

More Improvements Throughout

•

Events now support spellcheck and markdown formatting in descriptions.

•

You can create a Thought and attach a URL in one step by entering a URL
in either the Thought creation or Search box.

•

There are many additional Preference settings available to suit your
personal workflow.

•

Intelligence has been enhanced to recognize plural and singular forms of
the same word. This helps find context-sensitive matches in irregular
cases such as phenomenon and phenomena.

•

Now you’ll see clear Search feedback when searches are fully completed.
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